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Abstract – In structural Analysis generally the term frame means rigide structures having different 
component such as slab, Beam, Column, Footing etc. This all Components are casting together to form 
monolithic construction so it acts as single integral unit. There are many forces are acting on the 
building frame this acted force are pass through different component of frame. In some of structure extra 
live loads are act because of changes uses from residential to public or godown. For that the element of 
frame should be enough strong to sustain loads coming. In this Present work, we were anlysed columns 
and beams. for different load combination and improve integrity performance by using angles and Steel 
plate for strengthening. Finite element modelling is carried out for numerical analysis using ANSYS 
Workbench. Different models of beam and column are made in ANSYS Workbench and studying and 
comparison is done for Total Deformation and select optimum strengthen location for different loading 
condition. 

Keywords – ANSYS Workbench, Finite Element Model, Loads, Numerical Analysis, Total Deformation 

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - X - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 

I. INTRODUCTION 

In the industry of construction we consider columns 
and beams are rigide. Frame consists of different 
components such as beam and column. All Total load 
coming in building were going from this comp. so this 
compo. is enough strong and stable to transfer this 
load to the ground. Different forces are acted on the 
building such as vertical load as dead load of structure 
and live load, lateral loading is due to seismic waves 
i.e., due to earthquake and torsional force as wind 
load etc. for force sustainability strong joint is 
necessary i.e., Bending, lateral and torsional forces 
generated during loading and transfer of forces from 
one component to another. Connected members get 
failed in earthquake becauseof joint failure. For load 
sustainability col. and beams frequently strengthening 
is essential.[5] There are multiple numbers of method 
like batten plates of U shape is used in beams also 
distinct members were strengthened at nonidenticale 
points. fibre-reinforced polymer also used for jacket to 
existing column.    

M.I.S. Elmasry et al. (2018) [1] various techniques 
on cfrp retrofitting in the literature paper were studied 
by author. Results of his study said that strength of 
columnbeam connections were improved using 
jacketing steel   by wrapping sheets of cfrp  in cross 
setup. Furthermore, using the proposed technique 
proved to show better ductile response than other 
techniques suggested in some previous research 
related to the same study point.  

M.F. Belal et al. (2014) [2] Investigated in his paper 
about behaviour of strengthened steeljacketing 
column. The researcher demonstrated that capacity 
of column were depend upon various schemes of 
strengthening. shapeof main strengthning using C 
shape section, angles,platees and their numbers and 
size.he tested seven column out of which 2 were 
normal and remaining were strengthened. By using 
fem behaviour of these columns were studid. He 
verify his results with experimentals results. He 
conclude that significant strengthening results were 
given by batten plates used to C channel section. 
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Chunli Zhou Jinkun Sun et al. (2019) [3] reviewed in 
his paper about constructional methods of RC frames. 
Researcher introduced strengthened of beam by using 
exterior-warping U-Shaped steel plates. He derived 
formula brifly to compute carrying load capcity of 
warping exterior strengthened reinforced 
cementconcrete beams. Also he use softwere called 
abaqus to verify results got through theoretical setupe. 
Lastly he suggest warping of exterior U shape 
battenplates for rational method of strengthening.    

II. OBJECTIVES  

1. To analyse beam for two-point bending.  

2. To analyse beam for combined torsion and 
bending. 

3. To analyse the column for combined lateral 
and vertical loadings. 

III. METHODOLOGY 

Finite Element Approach [4] 

The different specimens were modelled by the FEM 
using ANSYS Workbench 15.0 In order to simulate as 
closely as possible the actual behaviour of the 
specimens. From the program menu list open the 
ANSYS 15.0 folder and select Workbench 15.0.  

Step 1 Unit Setting: Now is a good time to set the units 
that are going to work since the units typically do not 
change. For modelling a Beam and column of 
150X150X2000 MM and 150X150X1000 MM. units tab 
from project bar menu was selected to units change. 

 

Fig.1 Unit Settings. 

Step 2 Creating the Model: To perform a Static 
structural analysis, we will need to add the correct 
building block (system) from the Analysis Systems 
menu. ANSYS run different type of analyse like Fluid 
interaction thermalanylisis, static structure, buckling 
and dynamicanylisis, etc. Select the static structural 
block drag it into green box. For analysis in ANSYS 
workbench we need to define Engineering 
Data>Geometry>Model>Solution>Results. 

 

Fig. 2 Static Structure Standalone 

Step 3 Engineering Data: To have the correct 
behaviour modelled, need to define the type of 
material, along with its mechanical properties, using 
the Engineering Data cell. The selection of material 
was done by depending upon the physical and 
chemical properties of the material. These properties 
are used for analysis. 

Table 1. Material Data 

 

Step 4 Geometry: During this part, geometry was 
drew by sketch, these steps: Change the Units from 
the toolbar Units.go in XY Plan, and drawne witha 
2D shape. Then extrude this 2D shape into 3D 
model by extrude command in this we were gave 
length to that element. Similarly, the reinforcement is 
drawn by using sketching command. 

 

Fig.3 Modelling of element 
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Step 5 Model: The Model cell is the next one that will 
want to right-click on and select Edit to work with. 
Another new window will open that is tagged with a 
red ball and giant M icon, which stands for 
Mechanical. This Mechanical window will allow 
working on the meshing of the flat solid rectangular 
slab 

 

Fig.4 Modelling of Beam 

Step 6 Meshing: A mesh is needed to run Finite 
element analysis (FEA). The mesh takes the 3D part 
and represents it as many small elements that are 
connected by nodes. The FEA cannot run without 
having a mesh defined. In the Mechanical Tree 
Outline, Rightclick on Meshtab and then select the 
size of meshing as fine and then right click on Mesh 
and click on generate mesh the mesh will be 
generated. There are three types of mesh Course 
medium and fine out of which fine meshing is selected 
for more accuracy. 

 

Fig.5 Meshing 

Step 7 Setup: Use the Setup cell to launch the 
appropriate application for that system. Using these 
options will define loads, boundary conditions, and 
otherwise configure analysis in the application. Go 
back to the Project > Setup cell > Edit… Will work 
again in the same Mechanical model window but will 
need to right-click on the Static Structural leaf to 
access the functions needed. Many options will show 
when select Insert… as shown below. Here we 

selected different boundary conditions and different 
loading condition as per problem statement or as per 
strengthening pattern. We were selected cantilever 
beam simply supported beam and column with one 
end free and another fix this boundary condition was 
selected from this setup cell.   

 

Fig.6 Assigning boundary condition and loads 

Step 8 Results: Try to run the analysis now by right-
clicking on the Solution leaf in the LHS menu and 
clicking Solve. To set-up a viewer for the Equivalent 
Stress we will select 
Solution>Insert>Stress>Equivalent Stress. For the 
Total Deformation: To set-up a viewer for the Axial 
(Normal) Deformation we will select 
Solution>Insert>Deformation>Total. After inserting 
require output result right click on solution and click 
on evaluate all result to obtain different result. 

 

Fig.7 Deformation Tool. 
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Fig.8 Results window 

To analyse beam for two-point bending the study was 
done toinvestigate the effects of different 
Strengthening technique on beam for improving the 
bending strength of beam for that simply supported 
beam was analysed for two-point load of equal 
magnitude and equally spaced acted on beam and 
results were recorded for different models. Similarly, to 
analyse beam for combined torsion and 
bendingCantilever beam (one end Fixed another end 
free) were analysed. In this the vertical point load is 
given on free support and clockwise moment of 
different magnitude were applied on free end and 
results of different beam models were observed. 

Loads 

Table 2 Loading for Combined Torsion and 
Bending of Beam 

 

Different models of Beam: Following are the different 
types of beams analysed in ANSYS15.0 Beam 1 was 
simple bar Beam 2 was Bar with 10 mm Reinforcing 
Bar Beam 3 was a beam strengthened with 6mm thick 
plate to 3 side Beam 4 was beam strengthened with 
50 mm batten plates attached to 2 sides of beam and 
at bottom full plate were attached in Beam 5 only 
bottom of plate were strengthened with 6 mm thick 
plate in Beam 6 two equal angle of ISA 50X50X6 were 
attached to two corners of beam and in Beam 7 two 
equal angle of ISA 50X50X6 were attached to Middle 
one third span of beam. 

 

(a) Beam 1 

 

(b) Beam 2 

 

(c) Beam 3 

 

(d) Beam 4 
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(e) Beam 5 

 

(f) Beam 6 

 

(g) Beam 7 

Fig.9 Different Specimens of beams. 

For analyse the column for lateral and vertical 
loading,vertical as well as lateral load of different 
magnitude were applied on column and results were 
recorded after that strengthening technique was 
applied for avoiding failure of column and analysis will 
be done and changes in the results were observed.  

 

 

Load 

Table 3. load value for column 

 

Different models of Column: Following are the different 
types of Columns were anylized in ANSYS15.0 Col. 
1 is simple column without reinforcement Col. 2 was 
Column with four 10mm Dia bar in Col. 3 6 mm thick 
plate were attached to all four sides of column in Col. 
4 four ISA 50X50X6 mm attached to 4 corners of 
column and these angles were connected with each 
other with 50X6 mm batten plate. Col. 5 is same like 
Col. 4 but in this 100X6 mm batten plate is used for 
connecting Angles 

 

(a) Col. 1 

 

(b) Col. 2 



 

 

Ravikiran P. Jadhav1* Dr. Prashant M. Pawar2 Shrikrishna A. Gosavi3 Dr. Vidyarani S. 
Kshirsagar4 Dr. Manik G. Deshmukh5 

w
w

w
.i
g

n
it

e
d

.i
n

 

34 

 

 Analysis of Beam and Column for Improving the Integrity Performance 

 

(c) Col. 3 

 

(d) Col. 4 

 

(e) Col. 5 

Fig.10 Different Specimens of Columns. 

IV. RESULTS: 

In order to understand the behaviour of Normal 
specimen and strengthened specimens under different 
loading conditions Such as simply supported beam 
tested for two point bending cantilever beam tested for 
combined torsion and bending, and column is tested 
for combined lateral and vertical loads and 
deformation of each specimen is measured at regular 

interval of time and graph of deformations v/s time is 
plotted. 

Table. 4 Deformation of Beam For two points 
Bending. 

 

 

Fig.11 Deformation of Beam For two points 
Bending 

Table 5. Deformation 

 

 

Fig.12 Deformation 
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Table. 6 Deformation Value 

 

 

Fig.13 Deformation 

V. CONCLUSIONS: 

In paper behaviour of different strengthen beam, 
column models were investigated throughe FEM in 
ANSYS 15.0. these elements were strengthening by 
using steel plates and angle section at different 
location with different loading combinations. The 
Research focused on the batten plates and angle for 
enhancing the resistance to deformation from this 
study following conclusions were drawn. 

1. Using batten plates and angle for 
strengthening of beam and column proved 
effective since it increases the resistance to 
deformation. 

2. Strengthening element shows greater 
resistance to deformation as compared to 
normal element. 

3. Angle connected to middle one third span of 
beam for strengthening prove very effective as 
compare to other strengthening models for 
simply supported beam subjected to two-point 
bending. 

4. For cantilever beam subjectede to a combind 
torsion and bending strengthening with angle 
to middle one third proven very effective since 
it will undergo less deformation as compare to 
other models. 

5. Column strengthen with four angles connected 
to each corner and four batten plates 
connected to them at equal interval shows 

greater resistance to deformation as compare 
to other models. 
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